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Excel with Excel 2001
he world’s favourite
spreadsheet is, without doubt,
Excel. Admittedly it’s not up
against particularly stiff

competition and pretty much wins by
Homer Simpson’s two favourite words in
the English language: de-fault.

On the Mac, for instance, it only really
has the spreadsheet section of AppleWorks
to contend with, but however it happened,
you can’t get away from the obvious fact
that it’s everywhere.

Excel 2001 doesn’t bring a huge amount
of new stuff to the party but such
improvements as there are do make life
simpler for the new user and are very
welcome. If your experience of building
your own spreadsheets has hitherto been
limited to Apple/ClarisWorks, for instance,
the thought of “upgrading” to Excel can
seem a little daunting. It does loads more
than you’ll be used to, for a start, and if
your needs are modest you might think
that its power and range of features are

more than you need.
Which is a shame, because its power and

range of features are exactly what makes it
such a pleasant tool to use. You might
never want to do more than keep a record
of membership subs for the skating club or
work out how much your house purchase
is going to cost, but the ease with which
Excel can do it for you makes it almost
worth the investment on its own. And once
you’ve got started, who knows what else
you might decide to do.
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Microsoft’s Office 2001 package for Mac also contains the comprehensive, power-packed Excel spreadsheet
software. But you can use it to do simple things too – we show you how.
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When you open Excel the Project Gallery will be the
first thing you see (unless you’ve changed the
default preferences setting – click the General tab in

the Preferences window and you’ll find a check box at the
bottom) in which case you can open the Project Gallery from
the File menu. Click on List Wizard.

1 Like all Wizards, it’s a simple enough process. We’ll
be building our list from scratch so we’ll click the top
radio button. You can import the data from outside

if you need to – just click the relevant radio button and then
find the source file. You’ll need to have Query installed to do
this (from the Value Pack on the Office 2001 disc).

2 Step two is the first boring bit where you define all
the columns in your list. It’s easy enough to edit the
columns, to insert new ones, etc, but it’s a good idea

to have a rough outline before you begin – at least in your
head – of what you want to include and how you’re going to
set it out.

3

Tutorial 1: Set up your data lists
After years of painstaking research, Microsoft discovered what everyone knew all along – most Excel spreadsheets just

contain lists of data. So, Excel 2001 now has a list wizard to automate the whole thing.

Step three asks for a name (each list in a worksheet
will have a unique name, regardless of the name of
the sheet) and offers some self-explanatory options

(the not-quite-so-self-explanatory one, Show Visuals, refers to
the way the column headings are shown on the page).
Everything can be set later, so don’t worry too much.

4 The results of your labours don’t look too impressive
at this stage – you end up with a row of headings
with a blank row underneath – but the groundwork’s

been done and all that remains is to enter the data. You can
type it into each cell, or use the Form option from the List
section of the List toolbar (which opens automatically).

5 As the list builds up you can also use the Form
option to edit individual entries as well as to add
new ones. Excel might not have the power of a fully-

featured database app, but this new list feature does help it
to function as a simple database and that, if you’re honest, is
what you need most of the time.

6

Switching Visuals on (either by clicking the button 
in the Wizard or by clicking the Visuals button on
the new floating List palette) makes the column

headings easier to see. If you click the AutoFilter button,
you’ll also see some navigation arrows.

1 Click on the arrows and a menu like this pops down.
It enables you to sort the list quickly, using any
column. You can also show all, show the Top 10 (for

numerical entries), or create your own filter. Or, as we’re going
to do, you can opt for a filter based on the data in the column.

2 By clicking on The Big City we now have a list
displaying only those entries where our contact lives
in The Big City – it’s quick and intuitive. To alert us to

the fact that the list has been filtered, the row numbers
are now blue instead of black.

3

Tutorial 2: Sorting your data
Setting up filters used to be something of a chore, but if you click the button marked AutoFilter, it suddenly becomes

something of a breeze.
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Look at this record of monthly payments from a small
group of individuals. In its raw form it’s just a simple
list but it would be more helpful to be able to break

the payments down so that we could see what was paid each
month. Call up Pivot Table Report from the Data menu.

1 And as if by magic, a Wizard appears. As is usually
the case in Excel, you can take the data for the pivot
table from an external source, but we’re turning our

list into a table so we’ll leave the default button checked and
move on.

2 The next step asks us to select the range of data to
be used in the table and this is just a simple matter
of dragging a box around the list on our original

worksheet. The cell range is automatically entered in the box.

3

Tutorial 3: Using pivot tables
Pivot tables are uncommonly useful and have been around for a long time, but they’ve always been somewhat daunting

for the casual Exceller. Not so now, thanks to a new Wizard.

Step three asks where you want the list. We chose a
new sheet and this is what we ended up with. The
Pivot Table palette has a row of tools at the top and

our column headings along the bottom. To make a table, just
drag the headings to the appropriate part of the new table.

4 Pivot tables are not terribly intuitive, but using this
simple drag-and-drop system it’s easy to experiment.
For a display of monthly payments, drag Payment

Month into the Drag Row Headings Here box. Add Name,
then in the Drop Data Items Here box, put the Amount.

5 The result is this neat table showing monthly
payment totals with a grand total at the bottom. By
swapping the order of the column headings we

could show each person’s totals. The help file isn’t abundantly
helpful but you can pick up a lot just by mucking about.

6

Manipulating data
ne of the things that can baffle
the new Excel user is the way
the program organises its files.
When you open a new

spreadsheet in Claris/AppleWorks you get
just that: a single sheet. It can be as big as
you realistically need and you can break it
up into loads of different self-contained
sections, but it’s still just one big sheet.
Excel, on the other hand, opens up a
daunting thing that it calls a workbook,
immediately conjuring terrifying memories
of orange exercise books with “David Bowie
Rules” written on the cover and a note not
to forget your swimming kit on Thursday.

But no. Actually, an Excel workbook is
nothing more exciting than a collection of
“worksheets” which are just spreadsheets
that can share information easily between
each other. You can have a workbook

comprising one or many worksheets and
they do make life a little easier – instead of
scrolling around a spreadsheet to find the
monthly analysis (or whatever) you just
click on the tab at the bottom of the screen
that you thoughtfully labelled “Monthly
Analysis” and it takes you straight to the
relevant worksheet.

Brahms and who…?
With lists being the big thing in Excel’s
world at the moment, it’s not entirely
surprising that a great many of the new
toys revolve around getting information
into them. The first of these little marvels is
the List AutoFill, which can make light work
of some of the most tedious chores.

Imagine, for instance, that one column
of your list is to show the month and the
year of a particular event (let’s say for a

loan repayment calculator). The loan
started last year so you type “March 2000”.
Then you move down to the next cell and
type “April 2000”. And then your heart sinks
when you realise you’re going to have to do
this another 46 times for the rest of the
four-year loan. And even if you do one
year’s worth and copy it, you’ll still have to
change the last digit of the years.

But Excel comes to the rescue. Type in
the first two months and then select both
cells. Move the pointer to the bottom right
of the selection and it changes to a little
square with arrowheads in two corners.
Drag the selection down and the sequence
you started will be filled in automatically in
all the cells you select. It can do the same
with days of the week and with simple
incremental number sequences. It’s even
canny enough to be able to cope with a

O
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sequence that contains, say, every other
day, or only weekdays. It’s a remarkably
useful thing.

Don’t do it yourself
And while we’re on the subject of filling in
items in lists, what about auto complete? It
works in much the same way as the auto
complete feature in Word except that it
suggests items that have already appeared
in the same column. In the example above,
for instance, where a couple of US
presidents and a brace of British prime
ministers were making regular
membership payments to the Inline
Skating Club, but not in a predictable

sequence, we only had to enter each name
in full once. After that, just typing the first
few letters would invoke a grey box with
any possible names in it – highlighting one
and clicking on it was enough to enter it
into the cell in full.

Style vs substance
Obviously, the power of Excel is in its ability
to manipulate large amounts of data and
to recalculate huge numbers of sums and
other computations whenever even just
one piece of information is changed. But,
as with so much these days, just having
information isn’t nearly enough – you need
to be able to display it in an eye-catching

and entertaining way or the MTV
generation will have switched off long
before you get to the good bit.

Which is why presentation has always
been one of Excel’s strong points. You can
change fonts, insert graphics, and generally
jolly up dull information just as easily as
always. Slightly easier to use than before is
the new border drawing tool (there’s one in
Word 2001 as well). You can use it to draw
and erase cell borders (including cell guides
so you can merge cells more easily too).

And don’t forget AutoFormat. It isn’t
especially subtle, but it can make a plain
spreadsheet look halfway respectable if
you’re pressed for time. MF

Start by redefining the pivot table to show the names
and the amounts paid – simply drag the Month
header out of the table. Then select the names and

amounts (by dragging the pointer across them) and select
Chart from the Insert menu. The Chart Wizard starts up.

1 The Wizard offers simple choices at each stage. The
Assistant also opens up so you can access help
whenever you want it, but we switched it off

because it was getting in the way of the screenshots (he’s a
lovely little chap, but he does get in the way sometimes).

2 Hey presto! A simple and easy-to-understand pie
chart. The pivot table makes it easy to create charts
showing any combination of data you like without

having to muck about with your original list – it remains
unmolested by our charty shenanigans.

3

Tutorial 4: Make a chart or graph
Charts and graphs make everything seem much more straightforward. The improvements to charts aren’t in themselves

particularly exciting, but simpler pivot table manipulation makes chart creation a doddle.

We’ll stay with the same sheet and share the pie
chart with the world. Simply go to the File menu and
select Save as Web Page. If you prefer, you can

choose to save as a Web page from the options in the
standard Save dialogue box.

1 The Automate options help if you’re saving the
pages directly to your intranet Web server because
they enable you to produce a fresh version of the

Web page every time the worksheet is amended. If you don’t
want that, leave everything on its default setting.

2 The resulting Web page looks like this. You might
have to have a couple of goes (we did) because the
Web page doesn’t always look exactly like the

original and you might have to adjust the column widths on
the worksheet so they display correctly in the Web version.

3

Tutorial 5: Saving a worksheet as a Web page
Sharing information with other folks who have access neither to a Mac nor Excel is easy, as long as they have a Web

browser of some sort, because you can save your worksheets as Web pages.
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